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1 Warming Function of Nasal Passageways X        

2 Effect of Vascularity on Skin Temperature Recovery X        

3 Heart Rate as a Vital Sign  X       

4 Heart Rate and Exercise  X       

5 Heart Rate Response to Baroreceptor Feedback  X       

6 Effect of Coughing on Heart Rate  X       

7 Blood Pressure as a Vital Sign   X      

8 Blood Pressure and Exercise   X      

9 Diurnal Blood Pressure Variation   X      

10 Heart Rate and Blood Pressure as Vital Signs  X X      

11 Heart Rate, Blood Pressure, and Exercise  X X      

12 Analyzing the Heart with EKG    X     

13 Introduction to EMG    X     

14A Neuromuscular Reflexes (with Accelerometer)    X    X 

14B Neuromuscular Reflexes (without Accelerometer)    X     

15 Muscle Function Analysis    X     

16 Grip Strength Comparison     X    

17 Grip Strength and Muscle Fatigue     X    

18 EMG and Muscle Fatigue    X X    

19 Lung Volumes and Capacities      X   

20 Respiratory Response to Physiologic Challenges      X   

21 Analysis of Lung Function      X   

22 Oxygen and Aerobic Metabolism      X X  

23 Oxygen Extraction by the Lungs       X  

24 Effect of “Dead Space” on Oxygen Exchange       X  

 



 LabQuest 

 7 

Human Physiology with Vernier 7 - 1 

Blood Pressure as a Vital Sign 

Blood pressure is a measure of the changing fluid pressure within the circulatory system. It 
varies from a peak pressure produced by contraction of the left ventricle, to a low pressure, 
which is maintained by closure of the aortic valve and elastic recoil of the arterial system. The 
peak pressure is called systole, and the pressure that is maintained even while the left ventricle is 
relaxing is called diastole (see Figure 1).  

Mean arterial pressure (MAP) is not a simple average of the two pressures, because the duration 
of diastole is twice that of systole. MAP is used by emergency room and intensive care unit 
personnel as a measure of the adequacy of blood supplied to vital tissues (such as the brain, 
heart, and kidneys) when the blood pressure is dangerously low. 

Blood pressure is traditionally reported with the systolic pressure stated first and the diastolic 
pressure stated second. In adults, 120/80 and below is considered normal blood pressure. High 
blood pressure is 140/90 or above. The seriousness of low blood pressure, as well as the health 
risks of high blood pressure (also called hypertension), have been elucidated over the past 
several decades. High blood pressure is a major risk factor for a number of health problems 
including strokes and congestive heart failure. Diet and exercise are beneficial, but many people 
require medication for optimal blood pressure control.  

In this experiment, you will examine your blood pressure using the Vernier Blood Pressure 
Sensor. You will compare blood pressures taken before and after exposure to cold. The cold 
stimulus activates the sympathetic nervous system, resulting in hemodynamic changes that 
prepare the body for a “fight or flight” response (i.e., when fighting or running from danger). 

The sensitivity of blood pressure to harmful external or internal injuries makes it useful as a vital 
sign, an indicator of health, disease, excitement, and stress. 

Figure 1 
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OBJECTIVES 

In this experiment, you will 

• Obtain graphical representation of heart rate and blood pressure. 

• Compare blood pressure before and after exposure to cold stimulus. 

• Observe an example of sympathetic nervous system activation (“fight or flight” response). 

 
MATERIALS 

LabQuest ice water bath 
LabQuest App towel (paper or cloth) 
Vernier Blood Pressure Sensor  

 
 
PROCEDURE 

Part I  Baseline Blood Pressure 

1. Connect the Blood Pressure Sensor to LabQuest. There are two rubber tubes connected to the 
pressure cuff. One tube has a black Luer-lock connector at the end and the other tube has a 
bulb pump attached. Connect the Luer-lock connector to the stem on the Blood Pressure 
Sensor with a gentle half turn. 

2. Choose New from the File menu. 

3. Attach the Blood Pressure cuff firmly around the upper arm, approximately 2 cm above the 
elbow. The two rubber hoses from the cuff should be positioned over the 
biceps muscle (brachial artery) and not under the arm (see Figure 2). 

4. Have the subject sit quietly in a chair with his or her forearm resting on a 
table surface. The person having his or her blood pressure measured must 
remain still during data collection; there should be no movement of the arm 
or hand during measurements.  

5. Start data collection. Immediately pump the bulb pump until the cuff 
pressure reaches at least 160 mm Hg. Stop pumping. The cuff will slowly 
deflate and the pressure will fall. When the cuff pressure drops below 
50 mm Hg, the program will calculate blood pressure. At this point, you 
can stop data collection. Release the pressure from the cuff, but do not 
remove it. Data collection will stop automatically after 100 seconds. If the 
final pressure value recorded was not below 50 mm Hg, repeat this step to collect another 
run.  

6. Tap the Meter tab. Record the pulse and the systolic, diastolic, and mean arterial pressures.  

Part II  Blood Pressure Response to Cold 

7. Prepare an ice water bath for use in the next step. The subject will be instructed to place his 
or her opposite hand (the one to which the Blood Pressure cuff is not attached) in the ice 
water bath for 15 s. 

8. Collect data to examine the body’s response to cold. 

a. With the cuff still attached, have the subject from Part I put the hand of his or her  
non-cuffed arm in the ice water bath.  

Figure 2 
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b. As soon as the subject’s hand enters the ice water bath, start data collection.  

c. Pump the bulb until the cuff pressure reaches at least 160 mm Hg, then stop pumping.  

d. When data have been collected for 15 s, have the subject remove his or her hand from the 
ice water bath. 

e. When the blood pressure readings have stabilized (after the pressure drops to 50 mm Hg), 
the program will stop calculating blood pressure. At this point, you can stop data 
collection. Release the pressure from the cuff, and remove the cuff from the subject’s arm. 

 
9. Tap the Meter tab. Record the systolic, diastolic, and mean arterial pressures, and the pulse. 

 
DATA 

Table 1–Baseline Blood Pressure 

Systolic pressure 
(mm Hg) 

Diastolic pressure  
(mm Hg) 

Mean arterial pressure 
(mm Hg) 

Pulse 
(beats/minute) 

    

 

Table 2–Blood Pressure Response to Cold 

Systolic pressure 
(mm Hg) 

Diastolic pressure  
(mm Hg) 

Mean arterial pressure 
(mm Hg) 

Pulse 
(beats/minute) 

    

 
 
DATA ANALYSIS 

1. Describe the trends that occurred in the systolic pressure, diastolic pressure, mean arterial 
pressure, and pulse with cold stimulus. How might these be useful in a “fight or flight” 
response? 

2. Vasovagal syncope is a condition in which severe pain or fright activates the parasympathetic 
nervous system instead of the sympathetic nervous system, resulting in fainting. Keeping in 
mind that the parasympathetic system causes a response opposite to that of the sympathetic 
system, describe the hemodynamic changes that would explain this.  

3. As a vital sign, blood pressure is an indicator of general health. A high blood pressure 
(140/90 or higher) increases the risk of cardiovascular disease and strokes. Collect the 
systolic and diastolic pressures for the class and calculate the average for each. Rate the class 
average blood pressure using the following scale: 

Blood Pressure Category 

140/90 or higher High 

120–139/80–89 Pre-hypertension 

119/79 or below Normal 
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EXTENSION 

Blood pressure is traditionally obtained by using a stethoscope to listen to the brachial artery. 
The pumping of air into the blood pressure cuff acts to stop the blood flow through this artery. 
As the pressure is released, the blood again is allowed to flow. When the blood begins to flow, 
pulsations can be heard through the stethoscope. The pressure in the cuff at that time can be 
noted, and corresponds closely to the systolic blood pressure. As pressure continues to be 
released from the cuff, the pulsations of the artery become less audible. The pressure at which 
they disappear has been found to approximate the diastolic pressure. These sounds are known as 
Korotkoff Sounds. 

With a stethoscope, obtain the blood pressure of a classmate by listening for the appearance and 
disappearance of pulsations as the pressure in the cuff is released. Compare this to the blood 
pressure you obtained with the Vernier Blood Pressure Sensor.  
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Oxygen and Aerobic Metabolism 

Oxygen plays a key role in aerobic cellular metabolism, facilitating the conversion of glucose, 
protein, and lipids into usable energy. For every 6 molecules of oxygen used in the breakdown of 
glucose, 6 molecules of carbon dioxide are produced, along with water and adenosine 
triphosphate (ATP), according to the following equation:  

C6H12O6 + 6O2 → 6CO2 + 6 H2O + energy (heat or ATP) 
 
The average person uses 200–250 mL of O2 per minute at rest. This may increase to 2–3 L per 
minute during heavy exercise and to twice that amount in highly trained athletes. The increase of 
oxygen consumption is proportional to the amount of work performed up to a maximum level 
which is dependent on conditioning. At the start of exercise, anaerobic metabolism is used 
briefly, but this quickly changes to aerobic metabolism as blood flow to muscles increases.  

As O2 is consumed and CO2 is produced by muscle cells (and other cells), a pressure gradient is 
created between the cells, the interstitial fluid, and the bloodstream. A marked lowering of O2 in 
interstitial fluid as it is used up by cells leads to O2 diffusion from the bloodstream. While 
dissolved O2 provides an immediate supply to replenish the interstitial fluid and cells, the 
majority of O2 is carried on hemoglobin molecules. Oxyhemoglobin dissociates more readily as 
the oxygen concentration is lowered (and CO2 concentration increased), rapidly replenishing the 
supply of dissolved O2. CO2 diffuses from active cells (where it is produced in high 
concentration) to the interstitial fluid and bloodstream, where it is transported to the lungs mainly 
as bicarbonate. In the lungs, the opposite is true. O2 follows a pressure gradient from the alveoli 
into the bloodstream, and CO2 from the bloodstream into the alveoli.  

In this experiment, you will measure tidal volumes and oxygen concentrations of deeply inhaled 
and exhaled air at rest and after exercise. You will use these measurements to calculate the 
resulting differences in oxygen consumption.  

Important: Do not attempt this experiment if you have pulmonary or musculoskeletal problems 
that might be aggravated by exercise.  

 
OBJECTIVES 

In this experiment, you will 

• Obtain graphical representation of tidal volume and change in O2 concentration with 
breathing at rest and after exercise. 

• Calculate oxygen consumption at rest and after exercise. 

• Correlate your findings with clinical situations. 

 



LabQuest 22 

22 - 2 Human Physiology with Vernier 

MATERIALS 

LabQuest Vernier O2-Spirometer adapter 
LabQuest App disposable bacterial filter 
Vernier Spirometer nose clip 
Vernier O2 Sensor 4 cm (¾  in.) PVC pipe 

 
 
PROCEDURE 

Part I  Oxygen utilization at rest 

1. Connect the Spirometer and the O2 Gas Sensor to 
LabQuest. Choose New from the File menu. 

2. On the Meter screen, tap Rate. Change the data-
collection rate to 100 samples/second and the 
data-collection length to 40 seconds. Select OK. 

3. Assemble the apparatus (see Figure 1).  

a. Insert the O2 Gas Sensor into the vertical 
opening of the O2-Spirometer adapter.  

b. Identify the side of the Spirometer head marked “Inlet” and insert it into the adapter (the 
larger diameter side).  

c. Attach the bacterial filter to the smaller end of the adapter as shown. Caution: Do not 
puncture the filter material inside the bacterial filter.  

 
4. Hold the apparatus in one or both hands. Brace your arm(s) against a solid surface, such as a 

table, and choose Zero ► Spirometer from the Sensors menu. Do not zero the O2 Sensor. 
Note: The Spirometer must be held straight up and down during data collection (see 
Figure 1).  

5. Collect inhalation and exhalation data. 

a. Put on the nose clip. 

b. Start data collection.  

c. Taking deep breaths, begin data collection with an 
inhalation and continue to breathe in and out. Each 
respiratory cycle should last 8–10 s (4–5 s per 
inhalation and 4–5 s per exhalation). Continue 
breathing in this fashion for the duration of the 
experiment. Data collection will continue for 40 s.  

 
6. Tap the y-axis label of the flow rate vs. time graph and 

select Volume to display a graph of volume vs. time. 
If the baseline on your graph has drifted, choose 
Baseline Adjustment from the Analyze menu to bring 
the baseline volumes closer to zero, as in Figure 2. 
Select OK. 

Figure 2 

Figure 1 
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7. Determine the y for the volume vs. time graph. 

a. Tap the peak of the second peak of the volume graph and note the volume value.  

b. Tap the bottom of the valley that follows it and note the volume value.  

c. Calculate the y value and record it, to the nearest 0.1 L, as the total Breath 1 Pre-exercise 
Tidal Volume in Table 1. 

 
8. Repeat Step 7 for a total of three breaths, entering the y values for each breath in Table 1. 

9. Determine the y for the oxygen gas vs. time graph. 

a. Tap the peak of the second peak of the oxygen gas graph and note the oxygen gas value.  

b. Tap the bottom of the valley that follows it and note the oxygen gas value.  

c. Calculate the y value and record it, to the nearest 0.01 %, as the total Pre-exercise ∆O2 
Concentration in Table 1. 

 
 10. Repeat Step 9 for a total of three breaths, entering the y values for each breath in Table 1. 

Part II  Oxygen utilization during exercise 

 11. Begin running in place for two minutes, moving arms as well as legs.  

 12. At the end of two minutes, pick up the apparatus in one or both hands. Brace your arm(s) 
against a solid surface, such as a table, and choose Zero ► Spirometer from the Sensors 
menu. Do not zero the O2 Sensor. Note: The Spirometer must be held straight up and down 
during data collection (see Figure 1). 

 13. Collect inhalation and exhalation data. 

a. Put on the nose clip. 

b. Start data collection.  

c. Taking deep breaths, begin data collection with an inhalation and continue to breathe in 
and out. Each respiratory cycle should last 8–10 s (4–5 s per inhalation and 4–5 s per 
exhalation). Continue breathing in this fashion for the duration of the experiment. Data 
collection will continue for 40 s.  

 
 14. If the baseline on your graph has drifted, choose Baseline Adjustment from the Analyze 

menu to bring the baseline volumes closer to zero. Select OK.  

 15. Determine the y for the volume vs. time graph. 

a. Tap the peak of the second peak of the volume graph and note the volume value.  

b. Tap the bottom of the valley that follows it and note the volume value.  

c. Calculate the y value and record it, to the nearest 0.1 L, as the total Breath 1 Post-
exercise Tidal Volume in Table 1. 

 
 16. Repeat Step 15 for a total of three breaths, entering the y values for each breath in Table 1. 

 17. Determine the y for the oxygen gas vs. time graph. 

a. Tap the peak of the second peak of the oxygen gas graph and note the oxygen gas value.  

b. Tap the bottom of the valley that follows it and note the oxygen gas value.  

c. Calculate the y value and record it, to the nearest 0.01%, as the total Post-exercise ∆O2 
Concentration in Table 1. 
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 18. Repeat Step 17 for a total of three breaths, entering the y values for each breath in Table 1. 

 19. Compute the average value for each of the parameters measured and enter those values in 
Table 1.  

 
DATA 

Table 1 

 Tidal volume (L) ∆O2 Concentration (%) 

Breath Pre-exercise Post-exercise Pre-exercise Post-exercise 

1     

2     

3     

4     

Average     

 
 
DATA ANALYSIS 

1. Compare the tidal volumes of the four breaths you analyzed both at rest and post-exercise. Is 
it important for this experiment that resting and post-exercise tidal volumes be similar? 

2. Inhaled oxygen should have the same concentration at rest and post-exercise (approximately 
21%), yet the peak oxygen concentration values in the post-exercise run never achieve this 
value. What aspect of the experimental design accounts for this finding? 

3. Use the average values for Tidal Volume and ∆O2 Concentration (%) from Table 1 to 
calculate the average O2 consumed pre- and post-exercise per breath and over the combined 
four breaths: 

∆O2 Concentration (%)  Tidal Volume (L) = O2 consumed per breath 

O2 consumed per breath  4 breaths = O2 consumed over that time interval 

 
4. CO2 was not measured. What would you expect the volume of exhaled CO2 to be in this 

experiment at rest and after exercise? 

 
EXTENSIONS 

1. Oxygen consumption with exercise is directly proportional to the muscle mass being used. 
Demonstrate this principle by performing this experiment exercising with your legs only 
and/or with your arms only.  

2. Perform this experiment after exercising for varying lengths of time (1 minute or 5 minutes). 


